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Dear User,

Congratulations on choosing the Accu-Chek® Aviva Combo meter!
Your new meter will help you to manage your diabetes easily,
quickly and discreetly.

This Handbook is provided as part of your training on the new
Accu-Chek Aviva Combo meter.

It will help you to set up your meter, so that it quickly becomes
part of your daily life.

Roche Diabetes Care

This document is not intended to replace training by a qualified diabetes

= instructor, or the Owner’s Booklets (Instructions for use) provided with your
new meter.
Before starting therapy with your Accu-Chek Aviva Combo meter, please con-
sult your Accu-Chek Aviva Combo meter Owner’s booklets for detailed informa-
tion regarding warnings and precautions related to their use.

@ In this Handbook. the term “meter” a\wass refers to the Acco—Chek

Aviva Combo meter.
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I Your Accu-Chek Aviva Combo meter

1 Your Accu-Chek Aviva Combo meter

1.1 Summary of functions and features

Features

Convenient blood glucose (bG) testing.

Test results in five seconds.

Provide Bolus Advice.

Small sample size that allows testing from the fingertip.

Unreliable test results are detected automatically.

Keep record of events related to your diabetes management, for
example bG test results, bolus and basal insulin delivery, carbohydrate
intake, health events.

A variety of Reminders that help to remember tasks of your diabetes self-
management.



1.2 Button functions

Infrared (IR) Window

S @ =D Left/Right Soft Button
. Enter - oo
A Up |
¥ Down L %% Backlight Button
D> Right :
q Left
T — Teststrip Slot

® Power On/Off Button




Your Accu-Chek Aviva Combo meter

Key [Name Function

Power
0) On/Off - turn the meter on and off

Xt Backlight - adjust the backlight level (low, medium high)

- move through screens
d Leftarrow _ _ _
- scroll left in an information screen

Right - move through screens

arrow - scroll right in an information screen

- move through menus, functions and information screen
A  Uparrow - scroll up in an information screen

- increase a value in a setting screen

- move through menus, functions and information screen
Down

arrow

. scroll down in an information screen

- reduce a value in a setting screen



Key [Name Function

- select a menu or option

@ Enter - save changes
- exit

Left soft _

- button - select a menu on the display above the button
Right soft _

= button select a menu on the display above the button
Press and
hold _

D . itane. © Enables Keylock/ disables Keylock

ously



I Getting bolus advice from your meter

2 Getting Bolus Advice from your meter

The Bolus Advice function on your meter will provide you with recommendations
on the amount of insulin for food intake and for correcting bG levels that are
not within your Target Range. In the following chapter you will learn how to
program all your individual settings for the bolus advice calculation and how
to use Bolus Advice in your day-to-day life.

2.1 About Bolus Advice

The Bolus Advice function of your meter provides you with bolus recommenda-

tions based on your:

- Current bG test result

- Expected food intake

- Current health or activity

- Individual settings, such as Carb Ratio, Insulin Sensitivity, and other settings
that will be explained later in this chapter.

When you have programmed these settings, you will only need to:
- Measure your bG level

- Enter the amount of carbs you are currently planning to eat

- Enter your current health or activity state

Your meter will then calculate the required amount of insulin based on your
personal settings. You can adjust the calculated dose as appropriate. After
confirmation, administer the insulin using your pen or syringe.

If you are interested in details of the calculation for the recommended bolus,
please refer to Appendix A, B, and C.
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2.2 Setting up Bolus Advice

Before you can start setting up the Bolus Advice function, you need to discuss
the required setting parameters with your healthcare professional. The following
settings are necessary:

Time Block settings

Time Blocks... split the day into periods, to facilitate the pro-
gramming of those settings that change
throughout the day, such as Insulin Sensitivity
and Carb Ratio. You only need to set the end-
time of a Time Block, as this is also the starting
time of the following Time Block. Five Time
Blocks are set up by default, but you can set up
up to eight if necessary. The following para-
meters can be set up separately for each Time
Block.

Target Range... is the range of your blood glucose, consisting of
a lower and an upper bG value that is conside-
red to be acceptable as long as you are fasting
(in the morning or before a meal). The target bG
will be calculated automatically as the average
between the upper and lower bG values.



Carb Ratio...

Insulin Sensitivity ...

Health Event settings

Health Events...

I Getting bolus advice from your meter

is the amount of insulin you need for one unit of
carbohydrates. You must program the Carb
Ratio for each Time Block you wish to set up.

is the amount of insulin you need to lower your
bG level by a given amount. You may know this
as the “correction factor”. You must program
this for each Time Block you wish to set up.

are percentages that allow you to adjust the
calculated insulin amount to allow for individual
needs and health status; for example, when you
are planning physical activity (subtract percent-
ages) or you are ill (add percentages). You can
set percentages for:

- Exercise 1

- Exercise 2

- Stress

« lllness

- Premenstrual

You cannot adjust Fasting.

11



Advice Option settings

Meal Rise...

Snack Size...

Acting Time ...

Offset Time...

12

is an increase in your bG level that is acceptable
after a meal. After a meal, the Meal Rise is
added to your bG target. After a meal, the bG
target value plus the Meal rise value is accepted
without a correction bolus, as long as Acting
time and Offset time are effective (see the
explanations below).

is the amount of carbohydrates that is not to
be counted as a regular meal. A bolus will be
recommended but no Meal Rise is triggered.

is the time during which a bolus is effective.
The Acting Time starts afresh for each new
bolus.

is the expected time taken for your bG level to
fall after you inject a bolus. The Offset Time starts
afresh for each new bolus.



Getting bolus advice from your meter

13



14

Accu-CHEK

Language

English
Espaiiiol
Frangais

Language

Deutsch
Espaiiiol
Frangais

Press enter t
available o

Press © until the meter powers up.
The Accu-Chek screen appears for a few
seconds.

The Language screen appears. If you wish to
keep the default language, press &= to select

Next and continue with step 6.

Otherwise press @ to display the language
options.

Press A or ¥ to select the language.



Getting bolus advice from your meter

Press O to save the setting.
Press &) to select Save.

Time Format 24 hr ) )
Time i The Time/Date screen appears. If you wish to
Date 1Jan " 08 keep the default time, press &= to select Next
DD MMM YY . .
and continue with step 12.
Back 3 Next

@8 Time/Date

Time Forma 24 hr :

Time
HH MM
Dat 1J 08 i i
ate " 1Jan" 08 Qtherwise press @ to change Time Format.
Cancel 3

28 Time/Date

Time Forma A

Time 1hr N .

rita <R Press & or 7 to select 12hr or 24 hr Time Format.
oo vk v Press (O to save the changes.

Cancel %

15
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#® Time/Date

Time 12 hr

Time am
MM A/P

Date 1 Jan 08

13”08 Press @ to change the hour.

#® Time/Date

Time 12 hr

Time am
MM A/P

Date 1 Jan 08

Press A or ¥ to select the hour and O to save.
DD MMM YY

Cancel *
Continue using @, &, ¥ and @ to set
- Minutes

Time Format 12hr  « AM or PM if needed
Time 10: 30 am

HH MM _A/P

ove  EEEEEE D
DD MMM  YY - Month

- Year
Back % Next

Press &) to select Next.



Getting bolus advice from your meter

The Units screen appears.
Use @, &, ¥ and @ to set
- the units for carbohydrates
- the Insulin Increment
- the Max Bolus
Press &) to select Next
Hyper ~; 16.5 mmol/L
4.0 mmol/L
Select the upper (Hyper)  The \Warning Limits screen appears.
and lower (Hypo)
limits of your bG

= Warning Limits

il 12_5mmoI/L¢

Hypo =

seloct the upper (Hyper)  USE @D & 7 and @ to set the Hyper- (High bG)

and lower (Hypo) Warning Limit.
limits of your bG

Cancel *

17
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= Warning Limits

Hyper
A

e ORI Use @, &, ¥ and @ to set the Hypo- (Low bG)

Select the upper (Hyper) Warning lelt
and lower (Hypo)

limits of your bG Press &) to select Next.
Cancel b
Would you like to The Setup screen “Would you like to receive

receive bolus advice
from your Meter?

bolus advice from your meter?” appears.
Press & to select VYes.

p

. The Setup screen “Edit at least one time block
Edit at least one

time block by selecting by selecting a time block and pressing enter”

a time block
and pressing enter appears.
Press &) to select Next.
Back 3 Next

M Time Blocks

Start End
0:00 5:30 1 _
5:30 11:00 ‘ The Time Blocks screen appears.
11:00 17:00 : .
1700 5130 Press @ to enter the first Time Block.
21:30 0:00
Back »



4.0 mmol/L - 8.0 mmol/L
Carb Ratio
1 U for

Insulin Sensitivity

¥ Time Blocks

0:00 - 6:00
ol/L
arb Ratio
1 U for ==
Insulin Sensitivity

6:00

Insulin Sensitivity

¥ Time Blocks

0:00 -

6:00

Target Range

4.5 mmol/L - 6.5 mmol/L

Carb Ratio

for

Insulin Sensitivity

Getting bolus advice from your meter

The first Time Blocks screen appears.

Press @ to enter the end time box.

Press A or W to select the end time.

Press O to save the setting and move to the
lower target limit box.

Press O to enter.

Press & or W to select your lower target limit.
Press O to save and move to the upper target
limit box.

Press O to enter.

Press A or W to select your upper target limit.
Press () to save and move to the insulin for carb
box.

Press O to enter.
Press A or ¥ to enter the insulin amount.
Press ) to save and move to the carb box.

19



Press O to enter.
¥ Time Blocks Press A or ¥ to select the amount of carbs

Target Range 3 :
aeman esm==r  covered by the amount of insulin,

Carb Raﬁm Press @ to save and move to the insulin for bG
1U

Insulin Sensitivity bOX-
i for —1 Press @ to enter.

Press A or ¥ to select the insulin amount.
Press ) to save and move to the bG box.

25
Press O to enter.
(B RENEE Press & or ¥ to select the decrease in bG
4.5 mmol/L - 6.5 mmol/L
Carb Ratio expected for the insulin amount.
Insulir11 lSJefr?sritivity b Press Q to enter.
10U for EETIMA|  Press &) to save and exit to the Time Blocks
screen.
@ E Time Blocks
Sé?go s . Press & or w to move to the next Time Block.
‘ Press @ to enter.
o e The settings from the first Time Block will be
21:30 0:00 copied to all other Time Blocks.
S ‘ 28 press @ to select Next.

Repeat steps 20 to 26 accordingly to setup all Time Blocks as necessary.
Press &0 to select Next.



Exercise 1
Exercise 2 0%
Stress 0%
lliness 0%
Premenstrual 0%

Back % Next

¥:Health Events

Exercise 1
Exercise 2 1 5 ° hd

Stress 0%

lliness 0%
Premenstrual 0%
Exercise 1
Exercise 2 -20%
Stress +10%
lliness +50%
Premenstrual +10%
Back % Next

Getting bolus advice from your meter

The Health Events screen appears.
Press C to enter the Exercise 1 box.

Press A or ¥ to select the percentage as needed.
Press O to save.

Press & or ¥ to move to the next Health Event
you wish to setup.

Use @, & 7 and @ to setup all Health Events as needed.
Press &) to select next.

21
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Meal Rise 5.5 mmol/L

Snack Size -—

Acting Time 4:00 . -

Offset Time 100 The Advice Options screen appears.

HH MM

F: Advice Options

vieal RECHOQUUEIRS]  Press @ to enter the Meal Rise box.

Snack S
Acting Time 400 Press & or wto select the meal rise level.
Offset Time 1:00

wum  Press @ to save and move to the Snack Size
box.

Meal Rise

peal Rise m Press () to enter. |

Acting Time : Press A or ¥ to select the Snack Size.

Offset Time 90 Press @ to save and move to the Acting Time
box.

Cancel 3



Getting bolus advice from your meter

Meal Rise 3.0 mmol/L

poal Rise Press O to enter. -
Acting Time .

Press A or ¥ to select the Acting Time
Offset Time 0 Press @ to save and move to the Offset Time
box.

Cancel 3

Meal Rise 3.0mmollL  Press O to enter
Snack Size 79 ’ )
Acting Time 20 Press A or W to select the Offset Time.
Offset Time m Press @ to save.

Press &) to save all settings and select Next.

Cancel 3

New Snack Size has You receive the message that the new setting will

also been applied to be applied to the After Meal Reminder Snack

After Meal Reminder i

Size.
Press =0 to select OK.
Would you like to The screen “Would you like to set up bG
set up bG Test . -
Reminders? Test Reminders?” appears.

Press - to select No.

| C—
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Setip Gompleted The Setup Wizard is complete. .
Successfully Press &0 to select Next and enter the main
menu.

Switch of the meter.
Now you can continue with coding your meter.

Refore 300 can test Soor bG level with Soor meter SOU moust code it with the
& code chip acwmpansins the fest strip container. Yoo should also Per(:orm )
oD control test.

24
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3 Measuring your blood glucose (bG) level
3.1 Running a control test
You need:

- a new test strip
- a control solution level 1 or 2. The control level is printed on the bottle label.

(1
Place your meter on a flat surface (for example,
a table) and insert the test strip into the Test
Strip Slot in the direction of the arrow. The
Q meter turns on.
Match Code to Vial
, ' s The “Match Code to Vial” screen appears. Make

sure the code number on the screen matches the

111 . .

——— code number on the test strip container.

Apply Sample

The “Apply Sample” screen appears and a beep
indicates that the strip is ready for testing.

@

26
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AphaliEng e

&

10:02 2 Feb 08

6.4

mmol/L

Menu Level

I Measuring
your blood glucose (bG) level

Remove the cap from the control solution bottle
and wipe the tip with a tissue.

Squeeze the bottle until a tiny drop forms at the
tip. Apply the drop to the front edge of the yellow
window of the test strip.

The “Analyzing” screen appears as soon as you
have applied enough solution. Wipe the tip of the
control solution bottle and then put the cap on
the bottle tightly.

The “Control Result” screen appears.

27
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[ Control Result
10:02 2 Feb 08

| O

=3
-
@ Level 1

l Level 2

ancel

op
I.

[ Control Result
10:02 2 Feb 08

0.4 Level 1

mmol/L  Within range

Menu

Compare the result to the acceptable range
shown on the label of the test strip container.
Press &0 to display the Control Level screen.

Press A or 7 to select the control solution level.
Press ) to confirm.

When the control test result is within range,
the test strips and meter are working properly.
Remove and dispose of the test strip.




I Measuring
your blood glucose (bG) level

3.2 Performing a blood glucose (bQ) test

You need:
- your lancing device
- a new test strip

Prepare the lancing device according to the
instructions provided. Wash and dry your hands.
Place your meter on a flat surface (for example,
a table) and insert the test strip into the Test
Strip Slot in the direction of the arrow. The

¢ meter turns on.

Match Code to Vial
‘ War>re The “Match Code to Vial” screen appears. Make
1 ‘ sure that the code number on the screen matches

— the code number on the test strip container.

—

29



Apply Sample

The “Apply Sample” screen appears and a beep
indicates that the strip is ready for testing.

@

Prick your finger with your lancing device.
6
Gently squeeze your finger to get a blood drop.
Apply the blood drop to the front edge of the
yellow window of the test strip.
Adyiplzingle

The “Analyzing” screen appears as soon as you
have applied enough blood.




No Entry
B[ Pre Meal
Post Meal
Bedtime
v Other
Ilo Active Insuli =

I Measuring
your blood glucose (bG) level

Your bG Result appears on the display.

About three seconds later the detailed

“bG Result” screen appears.

Here you can enter information about meal time,
the carbs you are planning to eat and you
current health or activity state.

Press & or 7 to move to the Meal Time box

(or Carbs/Health accordingly), and press @ to
enter.

Press A or ¥ to select a value.

Press  to save the value. If you enter values for
carbs and health here, they are adopted to the
Bolus Advice screen.

Press &) to select Bolus and move to the Bolus
Advice screen.

TIn the next section wou will learn how to aet Bolus Advice after a bGr test.
& ” X 3

N
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Understanding your bG result

The coloured bar on the bG Result screen indicates the meaning of your bG
result:

If the bar is Your bG level is

above Hyper Warning Limit. It is highly recommended that

m I.
L alE you check for ketones and measure your bG level frequently.
I Blue above your Target Range but below Hyper Warning Limit.

I Green within your Target Range.
Yellow below your Target Range but above your Hypo Warning Limit.

below your Hypo Warning Limit. It is highly recommended
Red that you eat an appropriate amount of fast acting carbs
immediately.

Discuss appropriate action for each of the situations with your health care
professional.

32



I Measuring
your blood glucose (bG) level

3.3 Using Bolus Advice

Bolus Advice can only provide a reliable bolus recommendation, when a current
bG test result is available. Therefore it is highly recommended that you always
use Bolus Advice by starting with a bG test. When you use Bolus Advice with-
out a current bG test result, you will be prompted with a warning if the last bG

Test result dates back for more than five minutes.

Taking Bolus Advice from a bG Test

To take bolus advice from a bG test, you need:
- your lancing device

- a new test strip

33
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{)

Match Code to Vial

f | Code |

i

Apply Sample

K2

Prepare the lancing device according to the
instructions provided. Wash and dry your hands.

Place your meter on a flat surface (for example, a
table) and insert the test strip into the Test Strip
slot in the direction of the arrow. The meter turns
on.

The “Match Code to Vial” screen appears. Make
sure the code number on the screen matches the
code number on the test strip container.

The “Apply Sample” screen appears and a beep
indicates that the strip is ready for testing.



I Measuring
your blood glucose (bG) level

Prick your finger with your lancing device. Gently
squeeze your finger to get a blood drop.

(6
Touch the blood drop against the front edge of
the yellow window of the test strip.

Aphalizing e
The “Analyzing” screen appears as soon as you
> have applied enough blood.
o
]
8

Your result appears on the display.

35
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About three seconds later, a detailed “bG Result”
screen appears. Here you can add information
about the Meal Time, planned food intake or your
state of health, for statistical reasons, where
appropriate.

If ou use the bG resolt for Bolus Advice, uov cannot char\%e entries later

on. 1 herefore it is recommended that 300 add information about Meal Time

here.
No Entry
B Pre Meal
Post Meal
< Bedtime
v Other
JE= Active Insuli

Press & or ¥ to move to the Meal box (or Carbs/
Health accordingly), and press  to enter.

Press A or ¥ to select a value.

Press O to save the value. If you enter values for
carbs and health here, they are adopted to the
Bolus Advice screen.

Press &) to select Bolus and move to the Bolus
Advice screen.
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I Measuring
your blood glucose (bG) level

O Press O to enter the carbs Box.
Press & or ¥ to select the amount of carbo-
hydrates you are planning to eat.

® Press O to save and move to the Health box,
and press @ to enter.

Press A or ¥ to select your current state of
health, as appropriate.

® Press O to save and move to the Bolus
Amount box.

If you need to change the recommended bolus
amount, use @, A, ¥ and @ to change the
bolus amount and move to the Basal box.

® Otherwise, press 7 to move to the Basal box
directly.
Press O.
Press & or ¥ to set the basal insulin amount.
Press O to save.

Press &) to confirm and move to the Confirm
Bolus screen. Press &) to select OK.

Use your pen or syringe to administer the insulin
accordingly.

37



38



I Managing your data

4 Managing your data

Careful analysis of your bG data is an effective way for you and your healthcare
professional to control and manage your diabetes.

Your meter automatically stores up to 1000 diary records with their time and
date. You can review up to 250 diary records on your meter, or up to 1000
diary records using compatible software. These records are stored from the
newest to the oldest. It is very important to set the correct time and date, to
ensure that you and your healthcare professional can accurately interpret your
blood glucose results and that the bolus advice uses the appropriate settings
of the current time block.

Each diary record can contain:
- Date and time

- b@G test result

- Meal time (events)

- Carbs

- Health Event

- Bolus amount

You can display filtered or sorted diary data in graphical or table format.

Your meter generates reports, such as bG averages with standard deviations,
for the time period you choose (for example, the past 7 days or the past

30 days). Graphs can be a good way to view your bG results. Your meter can
display a line graph to depict bG record trends, a graph showing result ranges
for daily or weekly, and a pie chart with different colours to illustrate the
amount of test results within, above, or below your bG Target Range.

39



The following table depicts the icons used to display your data:

oo
Date of Record(s) 1Feb08  a"f° bG Value

SRS 20:06 3.8 TR
Time of bG Test - 17:33 @Y JL--7--0-| ---------- Bolus Icon
16:06 ¢f ]l 8.6
bG lcon: -« oo 13:52 & IL 3.3
10:02 ¢ @R 59 Health Event Icon

Back £ Select View

Meal Time Icon -

Carbs Icon

Icon Icon Name Description

- Icon is displayed when information exists for

ST this diary record regarding a blood glucose test.

Meal Time - Icon is displayed when information exists for
this diary record regarding Meal Time.

Carbs - Icon is displayed when information exists for

this diary record regarding carbs.

- Icon is displayed when information exists for

ARl e this diary record regarding Health Events.

Bolus - A Bolus has been deliverd.

40



Viewing your data

10:02 ot 2 Feb 08
§|ViewData |
[4 Add Data

® Reports

B* Data Transfer

1Feb08 &

[ 20:06 « #& 3.8
1733 &t N 7. |
16:06 &3¢ Il 8.6
1352 ¢cf ]l 3.3
10:02 $f @I 5.9

Back £ Select View

8/

Managing your data

From main menu press A or ¥ to select My Data.
Press @ to enter.

The Data screen is displayed and View Data is
highlighted.
Press O to enter.

The View Data screen appears.
Press & or 7 to view other records (the screen
scrolls if there are additional records).

41



1Feb08  ILU

10:02 & HE WL 1.8

The screen shows the bG test results in the right
column by default, but you can also view bolus or
carb data.

Press &) to select Select View.

Press & or ¥ to select carbs or bolus.

Press O to enter.

1 Feb 08 LU . ) ) -
| To view the details of a specific record press & or

17:33 @ HE L 24

16:06 dc¥E 1L 22! 7 to move the record.

1352 @S¢ Il 07

o S Press O to enter.
The View Detail screen is displayed.
Press < to view the previous or > to view next
(newer) record.

()
\

42




Managing your data

Editing your data
You can also use this function to add information on your Basal insulin.
You are in the View Detail screen in step 6 of the previous procedure.

B View Detail
16:06 1 Feb 08 M
& bG Value 8.6 mmol/L
@i Meal Time  Pre Meal .
& carbs 60g Press = to select Modify.
¥ Health Stress
Il Bolus 22U
16:06 2 Feb 08
& 8.6 mmol/L ) ) )
@ Press A or 7 to select the field you wish to edit,
60
£ heatr  and press @ to enter.
Bolus
16:06 1 Feb 08
& No Ent|
d».ty T Press A or wto change the entry, and € to save
Post Meal
= Bedtime the change.
n Other
Cancel #

Edit the other fields accordingly, as necessary.
Press &0 to save the changes and exit.

Warning
. You cannot ao back and edit data that have been
Diary Entry Used

For Advice osed with Bolus Advice!

Diary entry used for
Advice, modifications not
allowed

!
P
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Adding data
You can add data to a diary record for Carbs, Health, Basal, and Bolus, but not
for bG Test results.

From the main menu, press A or ¥ to select My
Data.
Press ) to enter.
10:00 gt 2 Feb 08
! View Data
M AddData |
- Reports Press <7 to move to Add Data.
E* Data Transfer Press D to enter
® [ 10f 00]
= 2 Feb 08
e 0
- Oy Press & or 7 to select a field.
Carbs
v pots Press @ to enter.
1 Bolus
B Add Data
€] N 00
i h FM ,\g 08 .
- o5 wm v Press & or wto edit the entry.
Carbs .
v pote Press @ to confirm.
I Bolus

44



] 9 20

HH MM
= 2 Feb 08
. EEEEE
v ea
1 Bolus
) 9 20

HH MM
= 2 Feb 08

DD MMM YY
& 459
L Health
1

Cancel & Save

8/

D

Managing your data

Use & 7 and @ to edit other entries accordingly.

Press &0 to save and return to the My Data
screen.

45
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Reporting data

In this menu you can view many different statistics for your bG test results,
such as bG averages and standard deviations. Standard deviation is a statistical
expression that indicates how far the individual test results are scattered
around the average.

From main menu, press A or ¥ to select My
Data.
Press @ to enter.
10:02 Fd 2 Feb 08
iZ View Data
i4 Add Data The My Data screen appears.
s A Press W to select Reports.
Press O to enter.
Trend
Standard D
v The Reports screen appears.
Target
Back #



bG Averages...

Trend

Standard Day
Standard Week
Target

B

O]
Q
=
3

Last 7 days 4
4™°| SD |[Tests

Overall 9.1| 4.5 37
Pre Meal 76| 3.7, 13
Post Meal | 11.2| 6.9 5
Bedtime 3.1 1

Other 9.7 28

2

Last 30 days 4
™| SD [Tests

Overall 8.8 4.3| 144
Pre Meal 74| 4.0 98
Post Meal |12.3| 6.4| 32
Bedtime 48| 3.0 8

Other 9.9 3.1
Back

Managing your data

shows you averages and standard devia-
tions for your bG test results for the catego-
ries Overall, Pre Meal, Post Meal, Bedtime
and Others. Test results without Meal time
entry only occur in the Overall category.
You can choose whether the averages and
standard deviations include the results of
the last 7, 14, 30, 60 or 90 days.

From the Reports screen, press @ to enter bG
Averages.

The bG Average screen appears.
Press  or D> to select the period of time included
in the calculation.

Press P to select Back and return to the
Reports screen.
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Trend... combines your bG test results for the categories

Overall, Pre Meal, Post Meal, Bedtime and Oth-
ers with the entries for Carbs and insulin. You
can view them either as a table or as a graphic.
You can choose whether the results of the last
8, 24 or 48 hours or 7 days are included.

Ex Reports
bG Averages

Standard Day From the Reports screen, press ¥ to select Trend.

Standard Week
Tt Press ) to enter.

A Last 8 hours 4 $
1 Overall k
»s verall The Trend screen appears.

L
il ) I,Hs Press A or ¥ to switch between the selection of
122' ‘120 the included period of time and the Meal Time
GO

120016001800 = field.



Managing your data

il Last 48 hours 4
1 Overall k
5% | | |5 When the time field is highlighted (8, 24 or
mmol . .15
P - %, 48hours or 7 days), press {or D> to select the
Y — ;-im ------- ;-I---i ¢ included period of time.
08:00 20:00 08:00
1 7st 8 hours B
5%- " |  When the Meal Time field is highlighted, press ¢
mmol . 115 . .
fo ' 0 OrDto select the Meal Time category you wish to
Yl E— I ¢ view.
14:00 16:00 18:00
1 Overall 3 . ;
2 Fob 08[8"™"| &g [1U Press .Qto switch between Graph view and
?g:gg 3.8 gg 24| Table view.
: 7.0 :
1606 g6l 20/ 22 Press @ to select Back and return to the
1352 | 36| 6007. Reports screen.
()
\
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Standard Day...

bG Averages
Trend

Standard Day

Standard Week
Target

o Last 7 days 4
b

L] Overall

6:00 12'00 18:00

Back b Table

shows you averages and standard deviations for
your bG test results for the categories Overall,
Pre Meal, Post Meal, Bedtime and Other calcu-
lated for each Time Block of your Bolus Ad-
vice/Time Block setting. You can view them
either as table or as graphic. You can choose
whether the averages and standard deviations
include the results of the last 7, 14, 30, 60 or

90 days.

From Reports screen press A or 7 to select
Standard Day.
Press O to enter.

The Standard Day screen appears.
Press A or ¥ to toggle between selection of
included period of time and Meal Time field.



4 Last 30 days 4
L] Overall 4

6:00 12'00 18'00
Back % Table

1 jast 30 days 4

6:00 12'00 18'00

Back f Table

F3

Last 7 days [
Overall ]

@"°| SD |Tests

0:00-4:00| 8.7/3.7| 3]
4:.00-8:001 8.0/2.7| 4
8:00-12:00/11.1| 8.0| 4
12:00- 16:00( 7.4/ 41| 9

Back # Graph

rY

Managing your data

When the time field is highlighted (7, 14, 30, 60 or
90 days), press { or D> to select the included
period of time.

When the Meal Time field is highlighted, press ¢
or > to select the Meal Time category you wish to
view.

Press & to switch between Graph view and
Table view.

Press = to select Back and return to the
Reports screen.
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Standard Week ... shows you averages and standard deviations for
your bG test results for the categories Overall,
Pre Meal, Post Meal, Bedtime and Other, calcu-
lated for each day of the week. You can view
them either as a table or as a graphic. You can
choose whether the averages and standard
deviations include the results of the last 7, 14,
30, 60 or 90 days.

bG Averages

Trend From the Reports screen, press A or ¥ to select
Standard Day
SIEMEEE iisels

Target Press O to enter.

b Last 7 days 4

L] Overall k

5% The Standard Week screen appears.

mmol . .

fo-B H g Press A or ¥ to toggle between the selection of
T s included period of time and Meal Time field.

M TW T F S S
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I Managing your data

(34
L] Overall
5- When the time field is highlighted (7, 14, 30, 60 or
T8 g H H H H g 90 days), press { or P> to select the included
Y S period of time.

M T W T F S S

[ 44 \
oro Meal
3. When the Meal Time field is highlighted, press
g H H H H g or D> to select the Meal Time category you wish to
Y —— e view.

M T W T F S S

Back bl Table

(54
- s oo e P18 TR0 to switch between Graph view and
Monday 12.4] 2.2 5] Table view.
w:;::gday 12:3 22 2 Press @ to select Back and return to the
Thursday | 88411 5. Reports screen.

()
\
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Target...

Ex Reports

bG Averages

Trend

Standard Day
Standard Week

FY a

I Above
I Within
.1 Below
Il Hypo

Back

Overall

¥

Last 7 days 4
4

-

Table|

shows you percentages for your bG test results
for the categories Overall, Pre Meal, Post Meal,
Bedtime and Other, that are
* above your Target Range
(between upper and lower bG target limit)
* within your Target Range
(between upper and lower bG target limit)
* below your Target Range
(between upper and lower bG target limit)
* below your Hypo Warning Limit.

You can view them either as a table or as a pie
chart. You can choose whether the percentages
include the results of the last 7, 14, 30, 60 or
90 days.

From the Reports screen, press A or 7 to select
Target.
Press @ to enter.

The Target screen appears.
Press A or ¥ to switch between the selection of
included period of time and Meal Time field.



Al x Last 14 days 4
b

L] Overall

\
1 &st 14 days 4

4 Pre Meal ]

L] Overall [
. Above 48%
I Within 32%
I Below 18%
M Hypo 2%
Back ¥ Graph

I Managing your data

When time field is highlighted (7, 14, 30, 60 or
90 days), press { or P> to select the included
period of time.

When the Meal Time field is highlighted, press ¢
or D> to select the Meal Time category you wish to
view.

Press &0 to toggle between Graph view and
Table view.

Press @ to select Back and return to the
Reports screen.
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4.1 Transferring data to a Computer

56

{7} View Data
[4 Add Data
[-* Reports

¥ Data Transfer

Menu

#» Data Transfer

1
g

Transferring Data

Position the infra-red window of your meter
opposite the infra-red cable of the computer, and
prepare the computer for data transfer

(for detailed instructions, see the instructions
provided with the according software on your
computer.)

From main menu on the meter press A or ¥ to
select My Data.
Press @ to enter.

Press & or ¥ to move to Data Transfer.
Press (D to enter.

The data transfer begins.

When the data transfer is complete the Data
Transfer Complete screen appears for three
seconds and then the meter turns off.



Managing your data
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I Using Reminders

5 Using Reminders

Managing your job, managing your family or managing school often require
your full attention. The meter can assist you managing your diabetes. With
reminders it helps you remembering a variety of diabetes related tasks.
Three different types of reminders are available to accommodate for different
requirements:

>
bG Test Reminders... remind you to test your bG level in special
situations:
- after a high bG test result (hyperglycaemia):
After High bG
- after a low bG test result (hypoglycaemia):
After Low bG
- after a meal: After Meal
>
Alarm Clock ... You can set up to eight different alarm clock
reminders per day.
You can set them to remind you of:
- a bG Test
- an injection
- other events
(>
Date Reminders... remind you of events like:

- Dr. Visit sounds at a special date
- Lab Test sounds at a special date
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To set Reminders

8/

60

From main menu, press A or ¥ to select
Settings.
Press (D to enter.
10:02 ] 2 Feb 08
#™ Reminders
Jl¥ Bolus Advice )
g Meter The Settings screen appears.
w# Sound/Vibrate .
 Time/Date Press D to enter Reminders.
bG Test Reminders
Alarm Clock
Date Reminders .
The Reminders screen appears.



I Using Reminders

bG Test Reminders - After High bG
This reminder will turn on the meter. You can dismiss it by pressing &=.
You can reschedule (snooze) it to occur in 15 minutes by pressing @&

_
Alarm Clock From the Reminders screen press A or ¥ to
Date Reminders .
select bG Test Reminders.
Press O to enter.
After Low bG Off .
After Meal of The bG Test Reminders screen appears.
Press O to enter After High bG.
The After High bG screen appears.

Remind i
i Press  to enter Reminder.
Remind After Press & or ¥ to select On or Off as needed.
of _ Press @ to confirm and move to the bG Thres-
hold box. The Hyper Warning Limit is set as bG

threshold for triggering the reminder by default.

Q

ancel #
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B After High bG

Remin
bG Th
Remin

Cancel

HH MM

%

B After High bG

Reminder
bG Threshol
Remind Afte

Cancel

8/

D
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On

L 1:302

E

To change the bG threshold press .

Press & or 7 to select the bG value as needed.
Press O to confirm and move to the Remind
After box.

Press O to enter.

Press A or ¥ to change the period after which
the reminder sounds as needed.

Press @ to confirm.

Press &= to save and return to the bG Test
Reminders screen.



I Using Reminders

bG Test Reminders — After Low bG
This reminder turns on the meter. You can dismiss it by pressing &.
You can re-schedule (snooze) it to occur in five minutes by pressing @

BReminders
bG Test Reminders
Alarm Clock
Date Reminders

o
)
Q
P

¥

B bG Test Reminders
After High bG Off
After Low bG
After Meal Off

1
=

Back

B After Low bG
Reminder
bG Threshold 5.0
Remind After

Ho
=4S

ancel #

@)

From the Reminders screen press A or ¥ to
select bG Test Reminders.
Press () to enter.

The bG Test Reminders screen appears.
Press A or ¥ to select After Low bG.
Press O to enter.

The After Low bG screen appears.

Press O to enter Reminder.

Press A or W to select On or Off as needed.
Press @ to confirm and move to the bG Thres-
hold box. The Hypo Warning Limit is set as bG
threshold for triggering the reminder by default.
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D
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B After Low bG

Remin
bG Th
Remin

Cancel

HH MM

¥

B After Low bG

Reminder
bG Threshol
Remind Afte

Cancel

On

0:20%

¥

To change the bG Threshold press .

Press A or ¥ to select the bG value as needed.
Press @ to confirm and move to the Remind
After box.

Press @ to enter.

Press A or ¥ to change the period after which
the reminder sounds as needed.

Press @ to confirm.

Press /=) to save and return to the bG Test
Reminders screen.



I Using Reminders

bG Test Reminders - After Meal

This reminder will turn on the meter. You can dismiss it by pressing &=.
You can reschedule (snooze) it to occur in five minutes by pressing G

BReminders

Alarm Clock 2
e From the Reminders screen press A or ¥ to

select bG Test Reminders.

Press O to enter.

After High bG Off
After Low bG Off :
The bG Test Reminders screen appears.

Press A or 7 to select After Meal.

Press ) to enter.

Romincor_SEEEEESD 1€ After Meal screen appears.
gnack dSI:fe Press @ to enter Reminder.
emin ter (0]
o Press & or ¥ to select On or Off as needed.

Press @ to confirm and move to the Snack Size
box.

The Snack Size is the same as entered in the Bolus Advice Op’rions.

& it here it wi | ice setti
£ If 300 chanse t here it will also be chanseo\ n the Bolus Advice sett ns.
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B After Meal

Reminder
Snack Size
Remind Afte

Cancel

gi0: <

HH MM

¥

B After Meal

Reminder
Snack Size
Remind Afte

Cancel

8/

D

66

On

(1:30%

E

Press @O to enter.

Press A or ¥ to select appropriate Snack Size as
needed.

Press O to confirm and move to the Remind
After box.

Press O to enter.

Press A or ¥ to select an appropriate period of
time as needed.

Press O to confirm.

Press &) to save and return to the bG Test
Reminders screen.



Alarm Clock
This reminder turns on the meter. You can dismiss it by pressing &.
You can re-schedule (snooze) it to occur in 15 minutes by pressing &

bG Test Reminders

Alarm Clock

Date Reminders

HH MM

[ 0:00 | off

0:00 Off

0:00 Off

0:00 Off

0:00 Off

000

= Off

0:00 Off

0:00 Off

0:00 Off
Cancel % ]

Using Reminders

From the Reminders screen, press A or 7 to
select Alarm Clock.
Press O to enter.

The Alarm Clock screen appears.

Press A or 7 to move to the alarm clock you
wish to change.

Press O to enter the time box.

Press A or W to select the appropriate time for
the alarm.

Press @ to confirm and move to the Off or
purpose box.
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HH MM
9:00
0:00
0:00
0:00
0:00
Cancel & ]
[ 5
HH MM
9:00 bG Test
Off
0:00 Off
0:00 Off
0:00 Off
Cancel b Save

8/

D

68

Press @O to enter.

Press & or ¥ to select Off, bG Test, Injection or
Other as needed.

Press O to confirm.

Where appropriate, repeat steps 2 to 4 to set
more Alarm Clocks accordingly.

Press &0 to save and return to the Reminders
screen.



Using Reminders

Date Reminders - Dr. Visit
This reminder does not turn on the meter, but sounds as soon as you turn on
the meter on the selected day. You can dismiss it by pressing &.

bG Test Reminders
Alarm Clock :
From the Remmqlers screen, press A or w to
select Date Reminders.
Press () to enter.
The Date Reminder screen appears.
Press & or 7 to move to Dr. Visit.
Press O to enter.

Reminder The Dr. Visit screen appears.
Appointment Date/Time_—

[ On |

Off

Date > re @@ Press @ to enter the Reminder box.
DD MM

Time Press & or ¥ to select On or Off.

(Optional) "V Press @ to confirm an move to the Date line.




Reminder On
Appointment Date/Time

Date 08

DD MMM  YY
Time -
(Optional) HH MM
Cancel # Save

Reminder On

Appointment Date/Time
Date 12 Mar 08

Y
(Optiona

8/

70

Press @ to enter the day box.

Press & or ¥ to select the day.

Press @ to confirm and enter the month box.
Press & or ¥ to select the month.

Press @ to confirm and enter the year box.
Press A or ¥ to select the year.

Press @ to confirm and move to the Time box.
Press () to enter.

Press & or ¥ to select the time.

Press @ to confirm.

Press &) to save and return to the Date
Reminders screen.



Using Reminders

Date Reminders - Lab Test
This reminder does not turn on the meter, but sounds as soon as you turn on
the meter on the selected day. You can dismiss it by pressing =.

bG Test Reminders ]
Alarm Clock From the Reminders screen press A or 7 to
,
select Date Reminders.
Press O to enter.
Back %
The Date Reminder screen appears.
Press & or 7 to move to Lab Test.
Press O to enter.
Reminder The Lab Test screen appears.
ppointment Date/Time .
Date 5 Fol Press ) to enter the Reminder box.
S 2o MY Off  pPregs A or W to select On or Off,
(Optional) VI Press @ to confirm and move to the Date line.
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B ab Test

Reminder On
Appointment Date/Time

Date 08

DD MMM YY
Time -
(Optional) HH MM

Cancel #

Save

BLab Test
Reminder On
Appointment Date/Time

Date 12 Mar 08
DD MMM YY

Time
(Optional)

Cancel # Save

HH MM

Reminder On
Appointment Date/Time

Date 12 Mar 08
Y

Tim
(Optiona

8/

72

Press O to enter the day box.

Press A or W to select the day.

Press @ to confirm and enter the month box.
Press & or ¥ to select the month.

Press @ to confirm and enter the year box.
Press & or ¥ to select the year.

Press ) to confirm and move to the Time box.
Press O to enter.

Press A or ¥ to select the time.

Press @ to confirm.

Press &) to save and return to the Date
Reminders screen.



I Changing your system Settings

6 Changing your meter Settings

As your life or health situation may change, you may need to change some of

the values in your meter settings. Discuss with your healthcare professional
before you change settings.

From main menu press A or 7 to move to
Settings.

10:02 A 2 Feb 08
I#¥ Reminders

II¥ Bolus Advice
B Meter

& Sound/Vibrate Press O to enter. The Settings screen appears.
13 Time/Date

Use &, w and O to edit the particular setting as needed.

Where appropriate, press &= to save and exit.
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You will find the particular settings as follows:

Reminders
. .
» bG Test Reminders —> > After High bG
A e » After Low bG
Date Reminders

» After Meal
y Alarm Clock =——— > Alarm Clock 1-8

» Date Reminders — > Dr. Visit

» Lab Test
Bolus Advice
.
» Time Blocks =—— > End

Health Events

Advice Options » Target Range

» Carb Ratio
» Insulin Sensitivity
Back #
» Health Events ——> » Exercise 1
» Exercise 2
» Stress
» lliness
» Premenstrual

» Advice Options —> > Meal Rise
» Snack Size
» Acting Time
» Offset Time



Meter

Sound / Vibrate

4 Sound/Vibrate
Beeper

Vibrate Off
Key Sound On

Cancel # SEVE

Time/Date

Time Format 24 hr
Tme DD
HH MM

Date 2 Feb 08
DD MMM YY

Cancel ¥ SEVG

I Changing your system Settings

» Warning Limits ——> > Hyper (high)
» Hypo (low)

» Key Lock =———> ) ON/OFF

» Language
» Units » > Grams, BE, KE, CC
» Insulin Increment
» Max Bolus
» Beeper »  Off, low, medium, high
» Vibrate » > ON/OFF

» Key Sound =———> > ON/OFF

» Time Format
» Time

» Date
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Appendix A

Calculating a correct bolus is a tricky business.

I wou had 1o work it out ;SoorselQ
here’s what SOU would have To do.
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Appendix

Where to find the Bolus Advice settings on the meter

Manual calculation On your meter

Time dependence of

parameters ) _ _
(circadian rhythm) In Settings » Bolus Advice » Time Blocks

Time Blocks:

Insulin-to-carbohydrate ratio  \Ajithin each Time Block (in Settings » Bolus
Advice > Time Blocks)

Insulin Sensitivity:

Within each Time Block
(in Settings » Bolus Advice » Time Blocks)

Insulin Sensitivity/ correction
factor

Target Range:

Within each Time Block

(in Settings » Bolus Advice » Time Blocks)

The target value is calculated automatically as
midway between the upper and lower target
limits.

bG target level

In the bG Test Result screen or in Bolus
Advice. Select the value in Settings » Bolus
Advice » Health Events.

Insulin dose adjustment for
EXercise, stress, illness or
premenstruation
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Manual calculation On your meter

Prevention of double dosage |n connection with Acting Time
after meal and Offset Time (in Settings » Bolus Advice
» Advice Options).

Prevention of double dosage Offset Time ~ JAe

after a high bG test result after a correction bolus.
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Appendix B: Bolus Advice Calculations

In this section you will learn how Bolus Advice recommendations are calculated.
To make sure that the recommendations meet your needs, you must give the
Bolus Advice feature on your meter some extra information, as well as the
basic blood glucose (bG) and carbohydrate values. As a safety measure, Bolus
Advice will not work without this information.

Your healthcare professional will give you the information that you need for the
Bolus Advice feature.

Carbohydrate Units

Choosing how your carbohydrates will be measured is important. In this way,
Bolus Advice can give you an accurate result. You just select what carbohy-
drate units Bolus Advice will use to make its calculations. You can choose
between:

- Grams

- BE (=12¢9)

- KE (=10Q)

- CC (=159)
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Time Blocks

E Time Blocks

Your insulin needs may vary depending on the time of day, start End "
so using the same values and factors throughout the ‘
day would probably not suit your metabolism or lifestyle. 11:00 17:00

17:00 21:30

This could also lead to incorrect doses of insulin. 5750 0:00

Back 1

The screen above shows the Time Blocks feature within Bolus Advice. Time
Blocks consider your time dependent requirements when calculating your insulin
dose at different times of the day. You can program up to eight Time Blocks,
depending on your lifestyle. For example, your insulin needs in the morning or
evening may not be the same as those in the afternoon or at night, so you can
program these different periods as Time Blocks. There are no pre-defined Time
Blocks that you should follow. You can choose when a Time Block ends to suit
your lifestyle.




I Appendix

Within Time Blocks you will find the following settings:

¥ Time Blocks

Target Range
4.0 mmol/L - 8.0 mmol/L
Carb Ratio

1 U for 109
Insulin Sensitivity

1 U for aanlnlellin

Cancel i Save

Target Range

Your bG results should be between the lower and upper values of the Target
Range as long as you are fasting (in the morning or before a meal). The target
bG will be calculated automatically as the average between the upper and
lower bG values.

Carb Ratio
The Carb (carbohydrate) Ratio defines how much insulin is needed to compen-
sate for a certain amount of carbohydrates.

Insulin Sensitivity

The Insulin Sensitivity (correction factor) shows how sensitive you are to a dose
of insulin. This is how much your bG drops in response to a certain amount of
insulin.

You can define all of these values separately for each Time Block. The Bolus
Advice calculation automatically takes these values into account for the time
of day.
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Without a meal - that means, when you do not enter Carbs - these
are the Calculations

If your bG level is ... ...the Bolus calculation is

-
—
O
o
>

=

(bG - Target bG) x Insulin Sensitivity
above Hyper Warning Additional recommendation to measure BG
more frequently and check for ketones.

between Upper Target

LimivandlbyberWaming (bG - Target bG) x Insulin Sensitivity.

between Upper and

Loper e L No correction bolus necessary.

between lower Target

Limit and Hypo Warning No correction bolus recommended.

Hypo Warning! Recommendation to eat fast
below Hypo Warning acting carbs.
Bolus Advice function not accessible!

hypo ¥

iz Remember the colored bar in the bGr fest—resolt screen tells where Sour
corrent bGr level is compareo\ to Sour ’ratge’r bG.

© (5]
. [ ]
10:02 5 9 mmol/L %
e SX)
& Carbs
L Health
Il= Active Insulin --U
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Before a meal - that means, when you enter Carbs - these are the
Calculations
The Meal bolus will always be calculated as:

carbs X insulin-to-carb-ratio

If your bG level is... ...the Bolus calculation is

(bG - Target bG) X Insulin Sensitivity +
Meal bolus. Additional recommendation to
measure bG more frequently and check for
ketones.

above Hyper Warning

hyper 4

between Upper Target (bG - Target bG) X Insulin Sensitivity +
Limit and Hyper Warning Meal bolus.

(bG - Target bG) x Insulin Sensitivity +
Meal bolus. Note that correction bolus can
be negative.

between Upper and
Lower Target Limit

(bG - Target bG) x Insulin Sensitivity +
Meal bolus. Note that correction bolus is
negative.

between lower Target
Limit and Hypo Warning

Hypo Warning! Recommendation to eat
below Hypo Warning fast acting carbs.
Bolus Advice function not accessible!
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Health Events .

If your routine was always the same from one day to the Exercise 1

next, then Time Blocks would provide enough information ~ £xorse? —

to calculate the correct boluses. However, sometimes your  lliness +20%
. . . . . . Premenstrual 0%

daily routine may be different and your insulin needs will

then change.

You can use Health Events to take into account various activities or events that
increase or decrease your insulin needs. You can choose different Health
Events depending on how you are feeling or what you are doing. For example,
sport or physical activity could decrease your insulin needs, whereas illness or
the menstrual cycle could increase your insulin needs.

Many of these activities or events do not occur at regular intervals, and Time
Blocks cannot take them into account. With Health Events, you can program
how much extra insulin (as a percentage of your usual bolus) you may need.
For example, when exercising, your insulin requirement may be 25% lower. You
and your healthcare professional should discuss what percentage to

program for each Health Event.
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When one of the programmed Health Events occurs in your daily life, you can
choose the Health Event on your meter so that Bolus Advice can calculate the
correct insulin dose. You can program five different Health Events:

- Exercise 1

- Exercise 2

- Stress

- lllness

- Premenstrual

The Bolus Advice screen and the bG Result screen call these Health with the
-icon.

Within Health on the Bolus Advice and bG Result screen you can also select
Fasting. However, you cannot adjust Fasting by percentage and it does not
scale advice calculations.

Advice Options — Meal Rise, Snack Size, Acting Time,
and Offset Time

¥ Time Blocks

Advice Options help to make sure that Bolus Advice does  start End

not recommend a second bolus for a blood sugar event,
such as a meal or a high bG level, that has already been 11:00 17:00
covered by a previous bolus. ;:gg 2(1,88

Back f

-
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Meal Rise

After a meal, bG levels usually increase by a noticeable amount, even in people
without diabetes. Depending on the type of meal, your bG can reach a maximum
about an hour after your meal and return to its original level after another one

to two hours. This is a normal process, so Bolus Advice takes this into account
using Meal Rise.

bG level ——Acting Time

W@L_E "
—Offset Time—

<
S
X
I - B -1
® ole o
Target Val B I e EE—— |
S ' TargetRange =~ L
| | | '
| | | :
! | | I
e L L Lo -
hypo 1 : ' Time
X
Current Bolus Currently allowed
bG values L] Meal Bolus not required O bG value: Meal Rise
Fig.1: Meal Rise

The dotted line shows how your bG level typically changes after a meal bolus.
Bolus Advice tolerates an increased bG level within the Meal Rise range
(green) without calculating an extra correction bolus. Each time you tell Bolus
Advice that you have consumed more carbohydrates than the Snack Size, the
Meal Rise entry is added to the bG target value. How long the Meal Rise lasts
(the width of the green area) is determined by the Offset Time and the Acting
Time.
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Snack Size

The Snack Size defines a certain amount of carbohydrates for which a meal
bolus is calculated, but no Meal Rise is triggered. No bG level above the Target
Range or currently allowed bG is tolerated for this amount of carbohydrates, so
Bolus Advice will calculate a correction bolus for any increase in bG after a
snack.

Acting Time

The Acting Time is the time for which the insulin delivered as a bolus is still
effective. It is the whole time for which an increase in bG after a meal bolus or
a correction bolus is taken into account. Bolus Advice will not recommend a
correction bolus for this time if your current bG level is less than the bG level
covered by the previous bolus (Meal Rise or a corrected high bG).

To choose the correct value for the Acting Time, you and your healthcare

professional should think about the following:

- Whether you use rapid-acting insulin analogue or fast-acting regular human
insulin (the Acting Time should be longer for regular insulin)

- Your average bolus amount (the larger your average bolus amount, the longer
the Acting Time should be)

You can program the Acting Time from 12 to 8 hours.
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Offset Time

The Offset Time is the time taken for the bolus to take effect. After the Offset
Time, your bG level should decrease because of the insulin, and at the end of
the Acting Time it should return to the target level.

The Offset Time must be at least 45 minutes, and the maximum value will be

limited by the Acting Time that you choose.
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Example
The following example explains the effect of the Offset Time and Acting Time:
bG level
hyper o
e © ©6 0 0 o
o »
. @
| (]
| ([ ]
! °
il el s ¢ T T -
| | [ J
Target Val —— e — - = — - - - == = = p L N
. __ . TargetRange =
hypo R R

Current
‘ .bG values D Sl

Fig.2: Example blood-sugar curve (bG-level)

You calculate and administer a correction bolus at 12 o’clock. The insulin
needs time to become effective, so your bG value (dotted line) may not be
significantly reduced, even by 2 o’clock. (If you had not administered the
correction bolus, your bG might even have increased.) You measure your bG
at 2 o’clock and it is nearly the same as at 12 o'clock. Between 2 o’clock and
4 o'clock the effect of the correction bolus, which is still active, will decrease
your bG level to a value within the Target Range.
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Fig.3: Example blood-sugar curve - double dosage

However, at 2 o'clock, if Bolus Advice took only your current bG value into
consideration, it would ignore the ongoing effect of your correction bolus.

It would then recommend an additional bolus to compensate for the raised

bG value. Where the effect of the two boluses overlap it could lead to a hypo-
glycemia (red line), because you would have had two boluses for the same
blood-sugar excursion.

Therefore, Bolus Advice always compares your bG result with the currently
allowed bG value, and not just with the target value for the current Time Block.
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The currently allowed bG value considers the following factors:

- The upper limit of the Target Range for your current Time Block

- Excursions beyond the Target Value that have had a correction bolus that is
still active (Acting Time)

- bG values that were tolerated as a Meal Rise and which have had a meal
bolus that is still active (Acting Time)

- The expected reduction of your bG level due to the effect of insulin during the
Acting Time (the decrease between the end of Offset Time and end of Acting

Time)
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Fig. 4: Corrected high bG

The above diagram shows an example of the effect of this rule. The first correc-
tion bolus at 12 o’clock remains active during the Acting Time (the width
of the blue area). If a measured value at 2 o'clock falls within the currently

allowed bG value (height of the blue area), no new correction bolus is calcu-
lated.
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bG level

Target Val

. Current
bG values

Bolus

Fig.5: Subsequent boluses

Where the measured value is greater than the currently allowed bG value, the
newly calculated bolus (light-blue) only considers the difference between the
current bG value (dotted line) and the currently allowed bG value (the height of
the blue area). During the Acting Time of the first correction bolus (the width

of the blue area), only the currently allowed bG value is used to calculate the
second bolus.
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Fig.6: Subsequent meal boluses
Subsequent meals

If you eat several meals in a row, the Meal Rise will not add up, but start afresh
for each new meal bolus.
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Appendix C

The Mathematical Basis for Bolus Calculations

Below is a list of the most important formulas and principles that Bolus Advice
uses to calculate your bolus. It is difficult to accurately calculate a bolus your-
self using these formulas (remembering to include the Acting Time and Offset
Time of your most recent boluses). This is why Bolus Advice is so useful. It will
save you a lot of time and avoids the risk of mistakes in your calculations.

Carbohydrates

This calculation is required when the bG result falls below the Hypo Warning
Limit. It is based on the other values defined for the current Time Block, and
the result recommends how much carbohydrate you should consume.

The words written in oranae in the formola refer to the se’r‘ring that SOU Gind
on the metfer screen.

Insulin rbohydr
Carbohydrates = (Target Range mean value - Current bG) x su X Carbo y(_j dlES
A bG Insulin
according to block definition from Insulin Sensitivity from Carb Ratio
Meal bolus
Insulin

Meal bolus = h intak —_———
eal bolus = Carbohydrate intake x Gt e

from Carb Ratio
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Currently Allowed bG Value

The currently allowed bG Value considers all blood sugar excursions, that
have already been treated by a meal- and/or correction- bolus. For all bG
test results below the currently allowed bG value no correction will be
recommended. The currently allowed bG value is calculated as follows:

blood glucose range covered by
correction bolus
according to block definition currently acting correction boluses

Currently allowed = Target Range mean value + Meal rise +

When no Meal Rise or correction bolus Acting Time is in effect, the value
for these in the formula is 0.

Correction Bolus

Generally, a correction bolus is only calculated if your current bG value is
above the hypo bG warning limit and outside of the Target Range. Addi-
tionally, it must be above the currently allowed bG value. Only correction
boluses greater than 0 will trigger an Acting Time.

r N

Insulin
A bG

from Insulin Sensitivity

Correction bolus = (current bG - currently allowed bG) x

N J

The size of the correction bolus depends on the following:

- If your bG is higher than the currently allowed bG, then:
Correction bolus = (current bG - currently allowed bG value) x Insulin
Sensitivity

- If the current bG is higher than the Hypo Warning Limit, and the current
bG is lower than Target Range lower limit, then the correction bolus that
is subtracted from the meal bolus is:
Correction bolus = (current bG - Target Range average value) x Insulin
Sensitivity
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Correction Bolus with Carbohydrate Intake

Whenever you tell Bolus Advice that you have consumed carbohydrates, the
related meal bolus is always offset against any correction bolus (even negative).
When you eat a meal, Bolus Advice also calculates the correction bolus for bG
results that are within the Target Range; more specifically, if your current bG
result is below the Target Range average value, or if your current bG is above the
currently allowed bG value.

Boluses that are calculated to be less than 0 are just displayed as 0.
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Changing your Meter Settings

1. From main menu press A or <7 to move to Settings.

2. Press (O to enter. The Settings screen appears.

10:02 2 2 Feb 08
L Reminders

Il Bolus Advice

=
Wy Sound/Vibrate

13 Time/Date

i+ Time Blocks

3. Use &, 7 and O 1o edit the particular setting as needed.
4. Where appropriate, press =0 to save and exit.

List of Meter Settings
Reminders > bG Test Reminders > After High bG
> After Low bG
> After Meal
> Alarm Clock > hh:mm (x8)
» Date Reminders > Dr. Visit
> Lab Test
Bolus Advice > Time Blocks > End
> Target Range
> Carb Ratio
> Insulin Sensitivity
> Health Events > Exercise 1
» Exercise 2
> Stress
> lliness
> Premenstrual
> Advice Options > Meal Rise
> Snack Size
> Acting Time
> Offset Time
Meter > Warning Limits > Hyper (high)
> Hypo (low)
> Key Lock > ON/OFF
> Language
> Units > Grams, BE, KE, CC
> Max Bolus
> Insulin increment
Sound/Vibrate > Beeper
> Vlibrate
> Key Sound
Time/Date > Time Format
> Time

> Date
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